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Program Overview
Click on the icon for an 
overview of Greeting Card 
Maker.

Tools/Toolbars
Click on the icon for a 
thorough description of 
Greeting Card Maker tools.

Interface
View the main interface of 
Greeting Card Maker.

Frequently Asked Questions
These are the most 
frequently asked questions 
about how to use Greeting 
Card Maker.

Tutorial
Click on this icon to get 
started in Greeting Card 
Maker quickly. 

Product Support
Click on the icon for 
instructions on accessing 
Expert’s Product Support.

Greeting Card Maker features the Zillion KajillionTM Rhyme Dictionary.    For a demo of 
the commercial version of Zillion Kajillion Rhymes, please check out the Zillion directory 
on this CD.

{button Windows Help,HelpOn()} {button Expert 
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Welcome to Expert’s Greeting Card Maker!
Create your own personalized greeting cards with Expert's Greeting Card Maker! This program gives you 
all the tools you need to create great cards - custom artwork, professionally written sentiments, and a 
simple to use interface that will make your creative work a snap. If you are in a hurry, we have included a 
collection of ready-made templates for many different occasions. Simply choose the occasion, select a 
design, add your personalized information, and print your card out in minutes. Or, if you are more 
creatively inclined, the program features a powerful set of tools, layout features, and content which you 
can mix and match to create your own card designs. Whatever the occasion and whatever your creative 
talents, Expert Greeting Card Maker is the perfect tool for creating the perfect card.

Great Features
Expert Greeting Card Maker contains many useful features for creating great greeting cards:
Choose from our collection of professionally written sentiments for dozens of occasions. Want to write 
your own greetings? Expert Greeting Card Maker features the Zillion Kajillion RhymesTM dictionary to 
help you find rhymes for over 10,000 words. A built in Thesaurus and Spell checker makes sure you find 
the right word - every time. 
Artwork? Expert Greeting Card Maker comes with hundreds of quality illustrations you can use in your 
cards, including 100 color clipart images from Imageline, Inc. And when it comes to printing, Expert 
Greeting Card Maker lets you print on regular 8 1/2" x 11" paper, or for a more professional look, on pre-
printed card stock from Fintech. 

Terms/Definitions
Click Press and release the mouse button (usually the left mouse button unless otherwise specified).
Double-Click Quickly press and release the mouse button twice.
Choose Highlight an item on the menu or dialog box to initiate an action or command, then press the 
Enter key or double-click your left mouse button.
Enter Press the Enter or Return key. 
Select Mark or choose an item so that the next action or command is carried out on that item. Highlight 
an option or choice from the menu or design document by clicking on it.
Drag and Drop Press and hold the mouse button and the shift key down while dragging the mouse. This 
allows you to move selected objects.
Border The line along the outside of an object.
Choose File—Open Choose a command from the applicable menu item. In this case, the command 
means to go to the File menu and select the Open command.
Control Menu Box The hyphen-shaped icon at the top left of the title bar of any window. 
Ctrl+Click Pressing and releasing the mouse button quickly while holding the control key on the 
keyboard.
Handles Small squares that appear on an object's perimeter when it is selected. By dragging the 
handles, you may re-size objects.
Object In the Card Editor Screen Object can refer to any item that can be selected and edited. There 
are Text Objects and Picture Objects. All Objects can be reduced, enlarged, and rotated.
Shift+Click Press and hold the mouse button and shift key down, while dragging the mouse. This allows 
you to move selected objects all at once.
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This is the first screen you see upon entering Expert’s Greeting Card Maker:

This screen appears after making your selections. This is the Main Interface of the program:



See Also:
Tutorial
Tools
Menus
Frequently Asked Questions

Choose a Card From the Card Rack
Select this option to choose from the ready-made designs available in the Card Rack 
Screen.

Create a Card From Scratch
Select this option to create a custom card in the Card Editor screen by combining any 
card background, clipart, and sentiments included in the program.

Open a Card You've Previously Created
Select this option to load from disk cards you have previously saved.



Card Editor Screen
This is the screen where you can customize and edit your card designs. Layout tools 
such as rulers, alignment options, and font editing are available here, including toolbars 
for adding clipart and for changing card backgrounds. 

Menu Commands
Use the menu commands to access all of the Card Editor screen's features through the 
keyboard. See Menus for more information.

Left Toolbar
This toolbar contains the main editing functions available in the program. Buttons 
included are: zoom in/zoom out functions, add text, shape text, signature, and 
sentiments, select objects, align objects, and draw order. See the Left Toolbar for more 
information.

Clipart Bar
This toolbar has two uses. The first is to display the clipart which you can drag-and-drop 
into your card. The second is to display printable card backgrounds and pre-printed card 
designs from different card manufacturers.

Status Bar
Look here for important information about the current card design being worked on, 
including card project type, card dimensions, and card background selected.

Navigator Bar
Use the buttons on this floating toolbar to view the outside and inside panels of the card, 
including the envelope. See Navigator Bar.

Top Toolbar
These tools provide shortcuts to the main commands of the program. See the Top 
Toolbar for more information.

Tutorial
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This section explains the inter-workings of Greeting Card Maker. Click on one of the following topics, or 
scroll through by clicking on the >> arrows located at the top of the help file for a detailed overview of the 
program.

Creating a Sample Card
Learn how to create your first card.
Types of Cards
This section covers Printable Cards, Cards on Pre-Printed Stock, Ordering Cards, 
Envelopes.
Choosing Ready Made Designs
This section describes the Card Rack.
Editing and Designing Cards
This section details Card Setup, Card sizes, Card Orientation, Working with Images, 
Importing Clipart, and Backgrounds.
Working with Text



Click on this topic to learn how to Insert Text, Format Text, Edit Text (Text Editor Screen), 
Add Special Text Effects, Shape Text, Add Sentiments, and use the Spell Checker, 
Thesaurus, and Rhyme Dictionary.
Using Signature Symbols
Learn how to Create and Insert Symbols.
Configuring Your Printer
Read this section to configure your printer properly.
Printing.
Click on this topic to learn about Print Align, Feeding Cards, and Printing.
Folding Cards
This section covers the ins and outs of folding cards. 
Preferences
Learn how to set your preferences.

Creating a Sample Card
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In this section, we will create a sample card in order to introduce you to the most common features
and controls in Greeting Card Maker. We create a Quarter Fold Card, customize it in the Card 
Editor Screen by adding our own text and graphics, and finally we will print it.
Start the Greeting Card Maker program. Click on the Construct Your Own Card button.

Select the Quarter Fold - Portrait button.



A blank card appears on the Card Editor Screen. We are now ready to begin constructing our 
design. First, lets select the card’s background art. On the Clipart Bar, click on the Card 
Backgrounds button. 

Choose a background image from the Clipart Bar and Drag-and-Drop it onto the card workspace. 
Now lets add our own text to the card. Double click on the text object that reads “Sentiment 1”. In 
the Text Editor, type “Santa Says…”



Single click on the text to highlight it. Change the font to “Bubblesoft” from the top toolbar control, 
click on the Center Justify button. Now re-size the text to a larger size by using the object 
handles.

Now, lets open the card to type our sentiment on the inside panel. Using the Navigator bar, click 
on the Inside button. 

You should now see the inside panels of the card.
Change the text of the text object that reads “Sentiment 2” to “Merry Christmas!” and re-size it in 
the same way as before.
On the Clipart Bar, click on the Clipart Mode button to switch modes so we can add clipart to our 
card. Select any image and Drag-and-Drop it onto your card.



We have now constructed a basic Quarter Fold Portrait Card. Our next step is to print it. Click on 
the Print button on the Top toolbar. Make sure your printer configurations are correct, and if they 
are, click on OK. (Note: Quarter Fold cards print out on only one side of the paper. Half Fold cards
and Pre-Printed Card Stock require two sided printing.) 
Now that we have our design printed on a full sheet of regular paper, we need to fold it in quarters 
(hence the name Quarter Fold). Holding the page upright, fold the upper half of the page 
backwards as shown:

Then, fold the bottom half as shown:

And that’s it! You have created your first card using Greeting Card Maker!



See Also:
Return to Main Tutorial 

Types of Cards
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Expert Greeting Card Maker lets you create and print greeting cards on a variety of different 
papers, sizes, and pre-printed card stock. Below is an overview of the different kinds of card types
available in the program. By choosing the card type when you begin a project, the dimensions and
margins will be set for the particular card.
Printable Designs

"Printable" designs are those cards that you can print out on regular 8 1/2" x 11" paper, or 
on blank card stock. 
Quarter fold - Also referred to as "french fold". This card is printed on a 8 1/2" x 11" paper
and is folded into quarters. Quarter fold cards can be made in portrait or landscape 
orientations. 
Half Fold - This card is also printed on a 8 1/2" x 11" paper and is folded in half. This type 
of card requires printing on both sides of the page.
Blank card stock - Blank card stock in different sizes can be used to print out your cards 
for a more "card shop" look. You can purchase blank stock cards directly from Hudson 
River Works. The size of the cards will be automatically set in the program when you 
select this option.
See Folding Cards for more information.

Cards on Pre-Printed Stock
Greeting Card Maker supports a collection of card designs from several leading 
manufacturers. You can preview each design directly on the screen. The status bar 
displays the manufacturer and item number for each card with which you can purchase 
the cards directly through an 800 phone number. Once you receive your cards in the mail 
you can feed them through your printer and print your own customized greetings on the 
inside. The card dimensions, designs, and blank 
areas will be automatically set by the program.

Envelopes
Greeting Card Maker allows you to print out designs on envelopes too, including sender 
and return addresses. You can double click on the fields for the return address and 
sender, then type in your information in the Edit Text dialog box. If your envelopes are not
the default size (see the status bar for dimensions) you must enter the proper dimensions 
in the Card Setup menu.

See Also:
Return to Main Tutorial 

Choosing Ready-Made Designs
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The Card Rack screen is where you can browse through the hundreds of ready-made printable 
card designs available in Greeting Card Maker.



Using the Card Rack Screen
First, select the occasion for your card by clicking on one of the tabs. A collection of thumbnails 
will appear showing the available ready-made templates. Double click on a thumbnail to see a full-
size preview of the card, including the inside of the card. 



Use the following list box to switch between Everyday ocassions (birthdays, graduation, etc.) and 
Holiday occassions (Christmas, Halloween, etc.). The tabs names change to reflet the new 
occassions.

Click on the Open button to view the inside panels of the card, or double-click on the card itself. 
Click on the Close button to close the card preview, and OK to return to the Card Rack.
To select a card, click on it once to highlight it, then press the Select button. 
See Also:

Return to Main Tutorial 
Types of Cards
Constructing and Editing Your Own Cards
Working With Images
Working With Text
Using the Card Editor Screen
Using the Signature Symbols
Configuring Your Printer
Folding
Creating Sample Cards

Occasions
Click on the tab for the desired occasion.



Thumbnail previews
View mini-representations of the ready-made designs and scroll through them here. 
Double-click on the card design thumbnail to see a larger size preview of the card and to
view the inside of the card.

Tone of Card
This controls allows you to shown only those card designs you want to view based on 
your selection of tone.

Thumbnails
When this box is checked, thumbnail previews of the card designs will be displayed so 
you can see more designs at one time. When it is un-checked, only one card will be 
shown, but in a larger size.

Thumbnail Scroll Control
Use this control to scroll through the card design thumbnails. The text will indicate the 
number of available cards and the number of the current design selected.

Select button
Click on this button once you have selected the card design you want to use. The 
selected card will be displayed in the Card Editor Screen where you can edit it and 
print it.

Help button
Click here for help on this screen.



Go Back button
Click here to cancel the selection and to return to the previous screen.



Constructing and Editing Your Own Cards
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Layout Editor Basics

1. Card Editor Screen - this is the screen where you can customize and edit your card designs. 
Layout tools such as rulers, alignment options, and font editing are available here, 
including toolbars for adding clipart and for changing card backgrounds. 

2. Menu Commands - use the menu commands to access all of the Card Editor Screen's 
features through the keyboard.

3. Left Toolbar - this toolbar contains the main editing functions available in the program. Buttons 
included are: zoom in/zoom out functions, add text, shape text, signature, and sentiments,
select objects, align objects, and draw order. 

4. Clipart Bar - this toolbar has two uses. The first is to display the clipart which you can drag-
and-drop into your card. 

5. Status Bar - look here for important information about the current card design being worked on,
including card project type, card dimensions, and card background selected.

6. Navigator Bar - use the buttons on this floating toolbar to view the outside and inside panels of
the card, including the envelope.

See Also:
Return to Main Tutorial 
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The Clipart Bar - The Clipart bar in the Card Editor screen serves as a palette for clipart and 
artwork where you can scroll through the available images and drag and drop your selections 
directly onto your card design. 

The Clipart bar has two modes:
Clipart Mode and Card Backgrounds Mode. 
You can toggle between these two modes using the buttons at the top of the Clipart bar.

See Also:
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Clipart Mode
In clipart mode you will see color clipart available in the 
program's clipart directory. You can scroll through all the 
images. To insert an image into your design, simply drag-
and-drop it from the toolbar to your card. 
Importing Images
To import images into your card design, click on the 
Browse button on the Clipart bar. Greeting Card Maker 
can import graphic images in the most popular file formats 
including .BMP, .PCX, .TIF, .GIF, .JPG, and more.
Note: If you import an image that is 256 colors or more you 
may experience a color shift on the screen if you are 
running Windows in 256 color or less. We recommend you 
run Windows in 16-bit color or higher for best results with 
Greeting Card Maker.

File List
All files of supported graphics formats will be shown here.



File Name
The highlighted file’s name will appear here.



Files of Type
Use this control to display only those files of a specified format.



Clipart Preview
A preview of the highlighted file will appear in this box.



Card Backgrounds
In Card Background Mode, you see a 
selection of card background artwork and 
pre-printed card designs. If you have 
selected any of the ready-made templates or
construct your own card projects, the Clipart
Bar shows card background art which you 
can select and prin on your cards. If you 
have selected a Pre-Printed Stock project, 
the Clipart Bar displays a number of card 
designs for cards that you can order from the
manufacturer. You are not to print these 
designs out as they are only included as a 
design aid.

Card Backgrounds
The printable designs shown under this selection can be printed out by the program. To 
choose a background, simply drag-n-drop in onto your ard project.Pre-Printed Card 
Designs - Greeting Card Maker lets you view a collection of pre-printed card designs from
several manufacturers that you can print your greetings on. You can purchase the cards 
directly from the manufacturer. The card design that is displayed on the screen will have 
the same dimensions, graphics, margins, and blank areas as the real card. When you 
receive your cards through the mail, simply insert them into your printer and your 
greetings will print on them just as they were displayed on the screen.You can scroll 
through a company's designs by choosing their name from the drop-down list-box, then 
drag-and-dropping the design onto the screen.
Ordering Cards
Click on the Order Cards button to see ordering information and phone numbers for the 
manufacturer.
Click Here to go Back to Working with Images 
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Greeting Card Maker gives you many options for entering, editing and formatting text. 
Edit Text - You can edit the text in any text object by double clicking on it. Doing so brings
up the Edit Text dialog box which contains several additional features. 
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Edit Box
Type your text here.



List Box
Whenever you click on the Antonym, Thesaurus, or Rhyme Dictionary buttons, the list
of available words is displayed here. See Spell Checking, Thesaurus and Rhyming.

Replace Button
Click here to copy a selected word from the list-box to the edit box. The highlighted word
in the edit box will be replaced by the new word.

Spell Check button
Click here to perform a spell check of the current text. If a word is mis-spelled, a dialog 
box will appear with suggestions for the correct word. See Spell Checking, Thesaurus 
and Rhyming.

Synonyms button
The built-in thesaurus feature allows you to look up words of similar meaning to the 
highlighted word. To use, highlight the word you wish to look up, then click on the 
Synonyms button. A list of words will appear in the list box on the right. Choose the 
word you want, then click on the Copy button on the left. See Spell Checking, 
Thesaurus and Rhyming.

Antonyms button
Works the same as the Synonyms button, but instead returns words of opposite 
meaning to the highlighted word.

Rhyme Dictionary button
You can use the rhyme dictionary to look up words that rhyme, or have the same ending 
sounds, as a highlighted word. To use, highlight a word with the mouse, then click on the
Rhyme Dictionary button. A list of words will appear in the list box on the right. Choose 
the word you want, then click on the Copy button on the left. 

Special Text Effects/Shaping Text/Adding Sentiments
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Special Text Effects
You can apply a number of different special effects to your text using the Text Effects dialog box 
by clicking on the Text Effects button on the Top toolbar. 



Shape Text
You can use the Shape Text feature to display text which can be warped into a number of 
different shapes. You can use all the Special Text Effects on Shape Text. 

Adding Shape Text - You can add Shape Text to your design by clicking on the Insert Shape 
Text button on the Left toolbar.



Editing Shape Text - Just like regular text, you can edit Shape Text by double-clicking on it.
Choosing Shapes - You can choose the shapes for Shape Text by clicking on the Special Text 
Effects button on the Top toolbar with a Shape Text object selected.
Adding Sentiments - Click on the Insert Sentiment button on the Left toolbar. 
Editing Sentiments - You can edit any sentiment in the same way as regular text by double-
clicking on it.
Sentiments
Greeting Card Maker has a collection of hundreds of sentiments for many occasions. You can 
scroll through these sentiments, and add them to your card at any time.

See Also:
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Shape Text

You can use the Shape Text feature to display text which can be warped into a number of 
different shapes. You can use all the Special Text Effects on Shape Text. 



Sentiments

Greeting Card Maker has a collection of hundreds of sentiments for many occasions. You can 
scroll through these sentiments, and add them to your card at any time.



Occasion
Use this control to select the occasion you wish to view sentiments for.



Front of Card/Inside of Card
Sentiments for the front panel and the inside panel of the greeting card are displayed here.



Scroll Controls
Press the arrow buttons to scroll through the available sentiments.    The display indicates
how many sentiments are available for the occasion selected.

Current Artwork Display
A preview of the current artwork is displayed here, along with a preview of the currently 
selected sentiment.

Color Fill
Use this feature to "color in" your text. You can choose from four different fill styles: solid,
gradient, radial, and conical. For all the fill styles, with the exception of solid fill, you must
choose a beginning color and an ending color for the fill pattern.

Shadow
Displays a "shadow" effect to give the text a "3-D" look. You can choose the position and
color of the shadow, including the distance.



Background
This option allows you to color in the background of a text object.

Preview



A preview of the current text is displayed here.



Shape Text Style
Choose the shape for your text from this list-box.



Show Outline
When this is checked, only the outline of the Shape Text will be displayed 



OK
Click here to select the current shape.



Cancel
Click here to abandon the operation.



Help
Click here for Help.



Solid Fill button
Click here for a solid color fill for the text.



Gradient Fill button
Click here for a top to bottom fill in the range of colors between the selected Start and 
End colors.

Radial Fill
Click here for a fill that radiates from the center in the range of colors between the 
selected Start and End colors.

Conical Fill
Click here for a fill that sweeps in a clockwise direction in the range of colors between 
the selected Start and End colors.

Start and End colors
Choose the starting and ending colors for the color fill presets.



Show Shadow
Click here to display the shadow effect on the selected text



Position
Choose the placement of the shadow effect of the selected text.



Spacing
Use this setting to determine the distance between the text and the shadow effect.



Color
Choose the color for the shadow effect.



Custom
Select the color for the text box background.



Spell Checking, Thesaurus, and Rhyming
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Spell Checking
Spell Check button - Click on this button to perform a spell check of the current text. If a word is 

mis-spelled, a dialog box will appear with suggestions for the correct word. 

Thesaurus
Thesaurus button - The built-in thesaurus feature allows you to look up words of similar meaning

to the highlighted word. To use, highlight the word you wish to look up, then click on the 
Thesaurus button. A list of words will appear in the list box on the right. Choose the word 
you want, then click on the Copy button on the left. 

Rhyming
Rhyme Dictionary button - You can use the rhyme dictionary to look up words that rhyme, or 

have the same ending sounds, as a highlighted word. To use, highlight a word with the 
mouse, then click on the Rhyme Dictionary button. A list of words will appear in the list 
box on the right. Choose the word you want, then click on the Copy button on the left. 

See Also:
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Greeting Card Maker lets you create, save, and re-use your own custom "signature symbols". 
These symbols are also referred to as "colophons" and are usually found on the back panel of 
greeting cards.



Creating a Signature Symbol
Your Signature Symbol can be any combination of clipart, text, and fonts you wish. Simply select 
all the objects that are part of the Signature Symbol, then Group them by using the Group option 
in the Edit menu.
Inserting a Signature Symbol
You can insert a saved Signature Symbol by clicking on the Insert Signature Symbol button on 
the left toolbar.
See Also:
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Using the Card Editor Screen
{button A,PI(`greetcar.hlp',`A')}{button B,PI(`greetcar.hlp',`B')}{button C,PI(`greetcar.hlp',`C')}{button D,PI(`greetcar.hlp',`D')}{button E,PI(`greetcar.hlp',`E')}{button 
F,PI(`greetcar.hlp',`F')}{button G,PI(`greetcar.hlp',`G')}{button H,PI(`greetcar.hlp',`H')}{button I,PI(`greetcar.hlp',`I')}{button J,PI(`greetcar.hlp',`J')}{button K,PI(`greetcar.hlp',`K')}
{button L,PI(`greetcar.hlp',`L')}{button M,PI(`greetcar.hlp',`M')}{button N,PI(`greetcar.hlp',`N')}{button O,PI(`greetcar.hlp',`O')}{button P,PI(`greetcar.hlp',`P')}{button 
Q,PI(`greetcar.hlp',`Q')}{button R,PI(`greetcar.hlp',`R')}{button S,PI(`greetcar.hlp',`S')}{button T,PI(`greetcar.hlp',`T')}{button U,PI(`greetcar.hlp',`U')}{button V,PI(`greetcar.hlp',`V')}
{button W,PI(`greetcar.hlp',`W')}{button X,PI(`greetcar.hlp',`X')}{button Y,PI(`greetcar.hlp',`Y')}{button Z,PI(`greetcar.hlp',`Z')}

For information on an item, click on it with the mouse when you see the  cursor.

Working with Layout Tools
Greeting Card Maker features a number of tools and features to assist you in creating your 
greeting card designs.
Viewing Tools

Navigator Bar

You can use the Navigator Bar to switch between the different card views - Front of Card, Inside
of Card, Outside of Card, and Envelope.

Zoom In/Zoom Out

You can use the Zoom In/Zoom Out tool to change the magnification of your current work area.
Selection Tools
Pressing the Selection button reveals the following buttons:

Object Alignment Tools
Use the Align Objects buttons to line up objects.

Draw Order Buttons



Special Layout Tools
Greeting Card Maker features visual aids to assist you in creating layout designs. These include 
rulers, paper margins, guidelines, snap to grids, and visible object shapes. All of these items can 
be turned on or off through the View menu on the top toolbar, or specific settings can be found for 
these in the Preferences option in the File menu.

Rulers

The Rulers in Greeting Card Maker show you the dimensions of the current card panel you are 
working on, and can serve as a handy guide when arranging text or graphics on the screen. The 
two "tick" marks that appear when you select an object show you the length and the width of the 
object you have selected. You can turn Rulers on or off through the View menu.

Guidelines

You can activate Guidelines by clicking on either of the rulers, holding down the left mouse 
button, and dragging the guideline. You can place guidelines anywhere on the page horizontally, 
as well as vertically. Once the guideline is in place, you can move objects towards it. When the 
object is within several pixels, the guideline becomes "sticky." In other words, it causes the object 
to attach itself to it. Guidelines are useful for aligning several objects along a specific position on a
page. You can reposition a guideline by dragging it. To remove a guideline, drag it back behind the
rulers. An Add Guidelines at Margins function exists in the Format menu. It automatically places
guidelines exactly on the paper margins.

Grids

The Snap to Grid feature sets up a series of points at set intervals that are "sticky" in the same 
manner as guidelines. You can move objects and "snap" them to these points. This is useful when
you want to layout several objects at precise locations. The Snap to Grid option can be turned 
on/off through the Preferences option in the File menu. The intervals for the grid can be set in 
intervals of 1/16" and can also be set through the Preferences option.

Status Bar



The Status Bar displays important information about the current card, including card dimensions, 
card type, background, and manufacturer and item number for pre-printed card designs.
See Also:
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Select All Text button
Use this button to select all text objects in your layout. This is useful when you want to 
change the font properties for all of your text at one time.

Select All Objects button
Use this button to select all objects - text, logos, and clipart.

Group button
When you have two or more objects selected, use this button to combine them into a 
single "object."

Ungroup button
Use this button to dismantle a grouped object into its separate components.

Align Left button
When a single object is selected, it aligns it to the leftmost paper margin. When two or 
more objects are selected, they are both aligned along their respective left margins.

Align Right button
Aligns a single object to the right paper margin and aligns multiple objects along the right
margins.

Align Top button
Aligns a single object to the top paper margin and aligns multiple objects along the top 
margins.

Align Bottom button
Aligns a single object to the bottom paper margin and aligns multiple objects along the 
bottom margins.

Center Vertically button
When a single object is selected, it is centered vertically on the page. When two or more 
objects are selected, they are centered vertically in relation to each other.

Center Horizontally button
When a single object is selected, it is centered horizontally on the page. When two or 
more objects are selected, they are centered horizontally in relation to each other.

Center on Page button
Places single or multiple objects in the center of the current page.



Bring Object To Front button
Brings the selected object to the front.



Send Object To Back button
Sends the selected object to the back.



Configuring Your Printer
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Configuring the Program to Work with Your Printer
Printing on pre-printed stock cards requires that you correctly feed cards into your printer.    The 
purpose of the Configure Print dialog box is to setup the program with settings for your particular 
printer, including manual feed operations.
You will need to run the configuration procedure if you intend to print cards on blank stock or on 
pre-printed cards.    This way the program will know where to print correctly on paper sizes smaller
than regular paper.    
When you run the Print Configuration routine, you should not have to use your printer’s setup 
options, such as landscape or portrait settings. These will be set automatically by the program.    
Changing any of these settings yourself may cause the cards to be printed incorretly.
When you select the Printer Configuration option from the File menu, the following dialog box 
will appear.    In order to properly setup your printer, follow each of the steps described:

Which way do you feed paper into your printer?
Most home printers today have the paper feed tray either on the front or on the back.    Select the 
option that matches your printer.
Which side of the feed tray do you align the paper to?
Printers usually require that you align paper to a certain side on the paper feed tray.    Some 
printers have a sliding paper guide for feeding paper that is not standard size or for envelopes.    
Choose which side your need to align to on your paper feed tray.
For manual feed, which way does the paper face?
When you do a manual feed, does your printer require that you place the paper face up or face 
down?
Perform Print Test 1
The first print test prints “Top of Page” on a regular sheet of paper.      This will serve as a 
reference guide for determining how your printer prints items in landscape mode.
When you have done Print Test 1, click on the Next button to proceed to the next series of 
configuration steps.



The page you just printed will say “Top of Page” on it.
You will need to re-insert this sheet into your printer again so that the side that says “Top of Page”
is printed on again and is upright.    This step is important in determining how your printer rotates 
items in landscape mode.    
If you are not sure how to perform a manual feed on your printer, please consult your printer’s 
User’s Guide.    
Perform Print Test 2
Print Test 2 will place the outline of a card over the original Test Print 1 sheet.    It will place the 
words “Top” on one of the two sides of the card outline.    
Choose the picture at right that best matches the new print out.
Select one of the pictures in the box on the right that matches the orientation of the card outline 
printed in Print Test 2.
Finish
Click here to complete your configuration.
See Also:

Printing

Configuring Your Printer



The page you just printed will say “Top of Page” on it.
You will need to re-insert this sheet into your printer again so that the side that says “Top of Page”
is printed on again and is upright.    This step is important in determining how your printer rotates 
items in landscape mode.    
If you are not sure how to perform a manual feed on your printer, please consult your printer’s 
User’s Guide.    
Perform Print Test 2
Print Test 2 will place the outline of a card over the original Test Print 1 sheet.    It will place the 
words “Top” on one of the two sides of the card outline.    
Choose the picture at right that best matches the new print out.
Select one of the pictures in the box on the right that matches the orientation of the card outline 
printed in Print Test 2.
Finish
Click here to complete your configuration.
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{button W,PI(`greetcar.hlp',`W')}{button X,PI(`greetcar.hlp',`X')}{button Y,PI(`greetcar.hlp',`Y')}{button Z,PI(`greetcar.hlp',`Z')}

For information on an item, click on it with the mouse when you see the  cursor.

Printing on Regular Paper
For Printing Quarter Fold cards, you do not need to do anything special with your printer as the 
entire card will print out on regular paper and on the same side of the page.
Half Fold cards require that you turn the paper over and feed it again through your printer.    You 
need to run the Print Configuration option in the File menu, so that the program knows how your
particular printer works with manual feed.
When you print a Half Fold card, the Print dialog box will instruct you on how to orient your paper 
as you feed it into your feed tray.
Printing on Blank Card Stock
Printing on Blank Card stock requires that you have previously run the Print Configuration option
in the File menu and that the program is correctly configured to work with your printer.    
When you print on Blank Card stock, a dialog box will appear with instructions for feeding the card
into your printer’s feed tray.      



The program will print out the Outside panels of the card first, then ask you to turn the card over 
and insert it into the paper feed tray again in order to print out the Inside panels.    Follow the 
instructions on the screen.    If your card does not appear to print correctly, run the Print 
Configuration option again and verify that your settings are correct.
If your print-outs appear off-center or print outside the card boundaries, you can use the Print 
Align feature in the File menu.    You can use the arrow keys to manually nudge the design in the 
desired direction.
Printing on Pre-Printed Card Stock
Printing on Pre-Printed card stock requires that you have previously run the Print Configuration 
option in the File menu and that the program is correctly configured to work with your printer.
Please note that the design you see on the screen is for layout purposes only and will not print out
on a Pre-Printed card, only the text and graphics you have added to it.
When you print on Pre-Printed card stock, a dialog box will appear with instructions for feeding the
card into your printer’s feed tray. 

The program will print out the Outside panels of the card first, then ask you to turn the card over 
and insert it into the paper feed tray again in order to print the Inside panels.    Follow the 
instructions on the screen.    If your card does not appear to print correctly, run the Print 
Configuration option again and verify that your settings are correct.



If your print-outs appear off-center or print outside the card boundaries, you can use the Print 
Align feature in the File menu.    You can use the arrow keys to manually nudge the design in the 
desired direction. See Printing Envelopes.
Print Alignment
In the event that your cards don’t print out, try the Print Align function.    Located in the File/Print 
Align menu, you can manually shift the card in the direction you want to align it in.    A graphic 
displays the amount that you are nudging your design over.

See Also:
Configuring Your Printer
Folding
Printing Envelopes

Printing Envelopes
{button A,PI(`greetcar.hlp',`A')}{button B,PI(`greetcar.hlp',`B')}{button C,PI(`greetcar.hlp',`C')}{button D,PI(`greetcar.hlp',`D')}{button E,PI(`greetcar.hlp',`E')}{button 
F,PI(`greetcar.hlp',`F')}{button G,PI(`greetcar.hlp',`G')}{button H,PI(`greetcar.hlp',`H')}{button I,PI(`greetcar.hlp',`I')}{button J,PI(`greetcar.hlp',`J')}{button K,PI(`greetcar.hlp',`K')}
{button L,PI(`greetcar.hlp',`L')}{button M,PI(`greetcar.hlp',`M')}{button N,PI(`greetcar.hlp',`N')}{button O,PI(`greetcar.hlp',`O')}{button P,PI(`greetcar.hlp',`P')}{button 
Q,PI(`greetcar.hlp',`Q')}{button R,PI(`greetcar.hlp',`R')}{button S,PI(`greetcar.hlp',`S')}{button T,PI(`greetcar.hlp',`T')}{button U,PI(`greetcar.hlp',`U')}{button V,PI(`greetcar.hlp',`V')}
{button W,PI(`greetcar.hlp',`W')}{button X,PI(`greetcar.hlp',`X')}{button Y,PI(`greetcar.hlp',`Y')}{button Z,PI(`greetcar.hlp',`Z')}

For information on an item, click on it with the mouse when you see the  cursor.

Printing envelopes in Greeting Card Maker is very similar to printing cards.    In order to get the 
best results you must enter the exact size of your envelope in the Card Setup dialog box in the 
Format menu.    Once you have entered the size, all you need to do is feed the envelope into your 
printer as shown and print.
Very Important!    
Most printers have a special way of feeding and printing envelopes built in, however this only 
works for standard size envelopes (size 10, etc.).
Feed your envelopes into the feeder tray like shown in the Print diagram, not like you usually feed 
them into your printer. 



Sample Envelope feeding instructions.    The diagram will show you the orientation specific to your
printer.

Folding Cards
{button A,PI(`greetcar.hlp',`A')}{button B,PI(`greetcar.hlp',`B')}{button C,PI(`greetcar.hlp',`C')}{button D,PI(`greetcar.hlp',`D')}{button E,PI(`greetcar.hlp',`E')}{button 
F,PI(`greetcar.hlp',`F')}{button G,PI(`greetcar.hlp',`G')}{button H,PI(`greetcar.hlp',`H')}{button I,PI(`greetcar.hlp',`I')}{button J,PI(`greetcar.hlp',`J')}{button K,PI(`greetcar.hlp',`K')}
{button L,PI(`greetcar.hlp',`L')}{button M,PI(`greetcar.hlp',`M')}{button N,PI(`greetcar.hlp',`N')}{button O,PI(`greetcar.hlp',`O')}{button P,PI(`greetcar.hlp',`P')}{button 
Q,PI(`greetcar.hlp',`Q')}{button R,PI(`greetcar.hlp',`R')}{button S,PI(`greetcar.hlp',`S')}{button T,PI(`greetcar.hlp',`T')}{button U,PI(`greetcar.hlp',`U')}{button V,PI(`greetcar.hlp',`V')}
{button W,PI(`greetcar.hlp',`W')}{button X,PI(`greetcar.hlp',`X')}{button Y,PI(`greetcar.hlp',`Y')}{button Z,PI(`greetcar.hlp',`Z')}

For information on an item, click on it with the mouse when you see the  cursor.

Folding is the last step in constructing your own greeting cards. 
Each type of printable card:

Quarter Fold Portrait
Quarter Fold Landscape
Half Fold Portrait
Half Fold Landscape
Note: Half Fold Landscape has its own folding method 

See Also:
Types of Cards

Folding Quarter Fold Portrait Cards
{button A,PI(`greetcar.hlp',`A')}{button B,PI(`greetcar.hlp',`B')}{button C,PI(`greetcar.hlp',`C')}{button D,PI(`greetcar.hlp',`D')}{button E,PI(`greetcar.hlp',`E')}{button 
F,PI(`greetcar.hlp',`F')}{button G,PI(`greetcar.hlp',`G')}{button H,PI(`greetcar.hlp',`H')}{button I,PI(`greetcar.hlp',`I')}{button J,PI(`greetcar.hlp',`J')}{button K,PI(`greetcar.hlp',`K')}
{button L,PI(`greetcar.hlp',`L')}{button M,PI(`greetcar.hlp',`M')}{button N,PI(`greetcar.hlp',`N')}{button O,PI(`greetcar.hlp',`O')}{button P,PI(`greetcar.hlp',`P')}{button 
Q,PI(`greetcar.hlp',`Q')}{button R,PI(`greetcar.hlp',`R')}{button S,PI(`greetcar.hlp',`S')}{button T,PI(`greetcar.hlp',`T')}{button U,PI(`greetcar.hlp',`U')}{button V,PI(`greetcar.hlp',`V')}
{button W,PI(`greetcar.hlp',`W')}{button X,PI(`greetcar.hlp',`X')}{button Y,PI(`greetcar.hlp',`Y')}{button Z,PI(`greetcar.hlp',`Z')}

For information on an item, click on it with the mouse when you see the  cursor.

Quarter Fold cards, as the name implies, are folded in quarters. All four sides of the card are 
printed on the same side of the page as shown below.
Step 1. Hold the page in front of you as shown below.

Step 2. Fold the top half of the page backwards, as shown. 

Step 3. Fold the left quarter of the card back, as shown.

See Also: Quarter Fold Portrait, Quarter Fold Landscape, Half Fold Portrait, Half Fold Landscape.
See Also:



Types of Cards

Folding Quarter Fold Landscape Cards
{button A,PI(`greetcar.hlp',`A')}{button B,PI(`greetcar.hlp',`B')}{button C,PI(`greetcar.hlp',`C')}{button D,PI(`greetcar.hlp',`D')}{button E,PI(`greetcar.hlp',`E')}{button 
F,PI(`greetcar.hlp',`F')}{button G,PI(`greetcar.hlp',`G')}{button H,PI(`greetcar.hlp',`H')}{button I,PI(`greetcar.hlp',`I')}{button J,PI(`greetcar.hlp',`J')}{button K,PI(`greetcar.hlp',`K')}
{button L,PI(`greetcar.hlp',`L')}{button M,PI(`greetcar.hlp',`M')}{button N,PI(`greetcar.hlp',`N')}{button O,PI(`greetcar.hlp',`O')}{button P,PI(`greetcar.hlp',`P')}{button 
Q,PI(`greetcar.hlp',`Q')}{button R,PI(`greetcar.hlp',`R')}{button S,PI(`greetcar.hlp',`S')}{button T,PI(`greetcar.hlp',`T')}{button U,PI(`greetcar.hlp',`U')}{button V,PI(`greetcar.hlp',`V')}
{button W,PI(`greetcar.hlp',`W')}{button X,PI(`greetcar.hlp',`X')}{button Y,PI(`greetcar.hlp',`Y')}{button Z,PI(`greetcar.hlp',`Z')}

For information on an item, click on it with the mouse when you see the  cursor.

Quarter Fold cards, as the name implies, are folded in quarters. All four sides of the card are 
printed on the same side of the page as shown below.
Step 1. Hold the page in front of you as shown below:

Step 2. Fold the top half of the page backwards, as shown. 

Step 3. Fold the left quarter of the card back, as shown.

See Also: Quarter Fold Portrait, Half Fold Portrait, Half Fold Landscape.

See Also:



Types of Cards

Folding Half Fold Portrait Cards
{button A,PI(`greetcar.hlp',`A')}{button B,PI(`greetcar.hlp',`B')}{button C,PI(`greetcar.hlp',`C')}{button D,PI(`greetcar.hlp',`D')}{button E,PI(`greetcar.hlp',`E')}{button 
F,PI(`greetcar.hlp',`F')}{button G,PI(`greetcar.hlp',`G')}{button H,PI(`greetcar.hlp',`H')}{button I,PI(`greetcar.hlp',`I')}{button J,PI(`greetcar.hlp',`J')}{button K,PI(`greetcar.hlp',`K')}
{button L,PI(`greetcar.hlp',`L')}{button M,PI(`greetcar.hlp',`M')}{button N,PI(`greetcar.hlp',`N')}{button O,PI(`greetcar.hlp',`O')}{button P,PI(`greetcar.hlp',`P')}{button 
Q,PI(`greetcar.hlp',`Q')}{button R,PI(`greetcar.hlp',`R')}{button S,PI(`greetcar.hlp',`S')}{button T,PI(`greetcar.hlp',`T')}{button U,PI(`greetcar.hlp',`U')}{button V,PI(`greetcar.hlp',`V')}
{button W,PI(`greetcar.hlp',`W')}{button X,PI(`greetcar.hlp',`X')}{button Y,PI(`greetcar.hlp',`Y')}{button Z,PI(`greetcar.hlp',`Z')}

For information on an item, click on it with the mouse when you see the  cursor.

Half Fold cards, as the name implies, are folded in half. Half Fold Portrait cards will print designs 
on both sides of a page. 
Step 1. Hold the page in front of you as shown:

Step 2. Fold the left half of the page backwards, as shown. 

See Also: Quarter Fold Portrait, Quarter Fold Landscape, Half Fold Landscape.

See Also:
Types of Cards

Folding Half Fold Landscape Cards
{button A,PI(`greetcar.hlp',`A')}{button B,PI(`greetcar.hlp',`B')}{button C,PI(`greetcar.hlp',`C')}{button D,PI(`greetcar.hlp',`D')}{button E,PI(`greetcar.hlp',`E')}{button 
F,PI(`greetcar.hlp',`F')}{button G,PI(`greetcar.hlp',`G')}{button H,PI(`greetcar.hlp',`H')}{button I,PI(`greetcar.hlp',`I')}{button J,PI(`greetcar.hlp',`J')}{button K,PI(`greetcar.hlp',`K')}
{button L,PI(`greetcar.hlp',`L')}{button M,PI(`greetcar.hlp',`M')}{button N,PI(`greetcar.hlp',`N')}{button O,PI(`greetcar.hlp',`O')}{button P,PI(`greetcar.hlp',`P')}{button 
Q,PI(`greetcar.hlp',`Q')}{button R,PI(`greetcar.hlp',`R')}{button S,PI(`greetcar.hlp',`S')}{button T,PI(`greetcar.hlp',`T')}{button U,PI(`greetcar.hlp',`U')}{button V,PI(`greetcar.hlp',`V')}
{button W,PI(`greetcar.hlp',`W')}{button X,PI(`greetcar.hlp',`X')}{button Y,PI(`greetcar.hlp',`Y')}{button Z,PI(`greetcar.hlp',`Z')}

For information on an item, click on it with the mouse when you see the  cursor.

Half Fold cards, as the name implies, are folded in half. Half Fold Landscape cards will print 
designs on both sides of a page. 
Step 1. Hold the page in front of you as shown below:



Step 2. Fold the top half of the page backwards, as shown. 

See Also: Quarter Fold Portrait, Quarter Fold Landscape, Half Fold Portrait.
See Also:

Types of Cards

Setting Your Preferences
{button A,PI(`greetcar.hlp',`A')}{button B,PI(`greetcar.hlp',`B')}{button C,PI(`greetcar.hlp',`C')}{button D,PI(`greetcar.hlp',`D')}{button E,PI(`greetcar.hlp',`E')}{button 
F,PI(`greetcar.hlp',`F')}{button G,PI(`greetcar.hlp',`G')}{button H,PI(`greetcar.hlp',`H')}{button I,PI(`greetcar.hlp',`I')}{button J,PI(`greetcar.hlp',`J')}{button K,PI(`greetcar.hlp',`K')}
{button L,PI(`greetcar.hlp',`L')}{button M,PI(`greetcar.hlp',`M')}{button N,PI(`greetcar.hlp',`N')}{button O,PI(`greetcar.hlp',`O')}{button P,PI(`greetcar.hlp',`P')}{button 
Q,PI(`greetcar.hlp',`Q')}{button R,PI(`greetcar.hlp',`R')}{button S,PI(`greetcar.hlp',`S')}{button T,PI(`greetcar.hlp',`T')}{button U,PI(`greetcar.hlp',`U')}{button V,PI(`greetcar.hlp',`V')}
{button W,PI(`greetcar.hlp',`W')}{button X,PI(`greetcar.hlp',`X')}{button Y,PI(`greetcar.hlp',`Y')}{button Z,PI(`greetcar.hlp',`Z')}

For information on an item, click on it with the mouse when you see the  cursor.

Use this screen to setup your preferences:



See Also:
Using the Card Editor Screen

Desktop Color Button 
Click here to change the color of the Greeting Card Maker desktop work area.



Default Button
Click here to use the default color for the desktop work area.



Unit of Measurement
Select between Standard and Metric measuring units.



Snap to Grid
When this box is checked, objects on the Card Editor screen will “snap” to a grid.



Snap to Grid Settings
Use these controls to set the spacing for the snap grid.



Main Toolbar
{button A,PI(`greetcar.hlp',`A')}{button B,PI(`greetcar.hlp',`B')}{button C,PI(`greetcar.hlp',`C')}{button D,PI(`greetcar.hlp',`D')}{button E,PI(`greetcar.hlp',`E')}{button 
F,PI(`greetcar.hlp',`F')}{button G,PI(`greetcar.hlp',`G')}{button H,PI(`greetcar.hlp',`H')}{button I,PI(`greetcar.hlp',`I')}{button J,PI(`greetcar.hlp',`J')}{button K,PI(`greetcar.hlp',`K')}
{button L,PI(`greetcar.hlp',`L')}{button M,PI(`greetcar.hlp',`M')}{button N,PI(`greetcar.hlp',`N')}{button O,PI(`greetcar.hlp',`O')}{button P,PI(`greetcar.hlp',`P')}{button 
Q,PI(`greetcar.hlp',`Q')}{button R,PI(`greetcar.hlp',`R')}{button S,PI(`greetcar.hlp',`S')}{button T,PI(`greetcar.hlp',`T')}{button U,PI(`greetcar.hlp',`U')}{button V,PI(`greetcar.hlp',`V')}
{button W,PI(`greetcar.hlp',`W')}{button X,PI(`greetcar.hlp',`X')}{button Y,PI(`greetcar.hlp',`Y')}{button Z,PI(`greetcar.hlp',`Z')}

For information on an item, click on it with the mouse when you see the  cursor.

This is the Main toolbar.

See Also:
Left Toolbar
Navigator Bar
Menus

New Card button
Click on this button, or choose File Menu—New Card, to create a new card. 



Open Card button
Click on this button, or choose File Menu—Open Card, to open a previously saved card. The 
Open Card dialog box appears:

Select the drive where you have saved the card, highlight the desired card and click on the OK.

Saved Cards List
A list of cards saved in the default directory is displayed in this list box.    



Browse button
Click here to look for saved cards saved in a directory other than the default directory.



Preview
A preview of the highlighted file is displayed here.

Go Back button
Click here to cancel the action and return to the previous screen.



Help
Click here for Help.



Save Current Card button
Click on this button to save the current card. The Save As dialog box appears:

Print button
Select this button, or choose File Menu—Print to launch the print screen. 

Cut button
Click on this button, or choose File Menu—Cut to delete selected text to be pasted 
somewhere else in the card. 

Copy button
This button is used to copy selected text into another section. You can also choose File 
Menu—Copy.

Paste button
Click on this button, or choose File Menu—Paste, to paste selected text to new place in 



the card. 

Undo button
Click on this button, or choose File Menu—Undo, to undo the last executed command. 



Font button
Click on this button to choose a font. 

Font Size button
Click on this button to change the font size.

Font Color button
Click on the Font Color button to set the color of the selected text font. 

Underline button
Use this button to underline selected text. 

Bold button
This button is used to bold selected text. 



Italics button
Click on this button to italicize selected text. 



Text Left Align button
Use this button to align text to the left margin. 



Text Center Align button
This button centers selected text. 



Text Right Align button
Use this button to align text to the right margin. 



Text Effects button
Click on this button to set the effects of your text. The Text Effects dialog box appears:

Help button
This button calls up the on-line help manual.



Navigator Bar
{button A,PI(`greetcar.hlp',`A')}{button B,PI(`greetcar.hlp',`B')}{button C,PI(`greetcar.hlp',`C')}{button D,PI(`greetcar.hlp',`D')}{button E,PI(`greetcar.hlp',`E')}{button 
F,PI(`greetcar.hlp',`F')}{button G,PI(`greetcar.hlp',`G')}{button H,PI(`greetcar.hlp',`H')}{button I,PI(`greetcar.hlp',`I')}{button J,PI(`greetcar.hlp',`J')}{button K,PI(`greetcar.hlp',`K')}
{button L,PI(`greetcar.hlp',`L')}{button M,PI(`greetcar.hlp',`M')}{button N,PI(`greetcar.hlp',`N')}{button O,PI(`greetcar.hlp',`O')}{button P,PI(`greetcar.hlp',`P')}{button 
Q,PI(`greetcar.hlp',`Q')}{button R,PI(`greetcar.hlp',`R')}{button S,PI(`greetcar.hlp',`S')}{button T,PI(`greetcar.hlp',`T')}{button U,PI(`greetcar.hlp',`U')}{button V,PI(`greetcar.hlp',`V')}
{button W,PI(`greetcar.hlp',`W')}{button X,PI(`greetcar.hlp',`X')}{button Y,PI(`greetcar.hlp',`Y')}{button Z,PI(`greetcar.hlp',`Z')}

For information on an item, click on it with the mouse when you see the  cursor.

This is the Navigator Bar located on the bottom of the main interfaces screen:

See Also:
Left Toolbar
Main Toolbar

Front of Card
Click here to display the front panel of the greeting card



Inside of Card
Click here to display the inside panels of the greeting card



Back of Card
Click here to display the back panel of the greeting card.



Envelope
Click here to display the envelope.



Left Toolbar
{button A,PI(`greetcar.hlp',`A')}{button B,PI(`greetcar.hlp',`B')}{button C,PI(`greetcar.hlp',`C')}{button D,PI(`greetcar.hlp',`D')}{button E,PI(`greetcar.hlp',`E')}{button 
F,PI(`greetcar.hlp',`F')}{button G,PI(`greetcar.hlp',`G')}{button H,PI(`greetcar.hlp',`H')}{button I,PI(`greetcar.hlp',`I')}{button J,PI(`greetcar.hlp',`J')}{button K,PI(`greetcar.hlp',`K')}
{button L,PI(`greetcar.hlp',`L')}{button M,PI(`greetcar.hlp',`M')}{button N,PI(`greetcar.hlp',`N')}{button O,PI(`greetcar.hlp',`O')}{button P,PI(`greetcar.hlp',`P')}{button 
Q,PI(`greetcar.hlp',`Q')}{button R,PI(`greetcar.hlp',`R')}{button S,PI(`greetcar.hlp',`S')}{button T,PI(`greetcar.hlp',`T')}{button U,PI(`greetcar.hlp',`U')}{button V,PI(`greetcar.hlp',`V')}
{button W,PI(`greetcar.hlp',`W')}{button X,PI(`greetcar.hlp',`X')}{button Y,PI(`greetcar.hlp',`Y')}{button Z,PI(`greetcar.hlp',`Z')}

For information on an item, click on it with the mouse when you see the  cursor.

This is the Left Toolbar:

See Also:
Main Toolbar
Navigator Bar
Menus

Zoom In button
Use this tool to magnify the viewing area.



Zoom Out button
Use this tool to maximize the viewing area.



Insert Text button
Inserts a text object that can be edited.



Insert Shape Text button
Inserts a text objects that can be shaped.



Insert Symbol button
Inserts a logo from the logo directory.

 

Sentiments button
Use this button to insert sentiments.

Object Alignment Controls
Use this button to control selection and alignment functions. 

Selection Tools
Pressing the Selection button reveals the following buttons.

Select All Text button
Use this button to select all text objects in your layout. This is useful when you want to 
change the font properties for all of your text at one time.

Select All Objects button
Use this button to select all objects - text, logos, and clipart.



Group button
When you have two or more objects selected, use this button to combine them into a 
single "object."

Ungroup button
Use this button to dismantle a grouped object into its separate components.



Object Alignment Tools
Use the Align Objects buttons to line up objects.

Align Left button
When a single object is selected, it aligns it to the leftmost paper margin. When two or 
more objects are selected, they are both aligned along their respective left margins.

Align Right button
Aligns a single object to the right paper margin and aligns multiple objects along the right 
margins.

Align Top button
Aligns a single object to the top paper margin and aligns multiple objects along the top 
margins.

Align Bottom button
Aligns a single object to the bottom paper margin and aligns multiple objects along the 
bottom margins.

Center Vertically button
When a single object is selected, it is centered vertically on the page. When two or more 
objects are selected, they are centered vertically in relation to each other.

Center Horizontally button
When a single object is selected, it is centered horizontally on the page. When two or 
more objects are selected, they are centered horizontally in relation to each other.

Center on Page button
Places single or multiple objects in the center of the current page.



Bring Object To Front button
Brings the selected object to the front. 



Send Object To Back button
Sends the selected object to the back.



Menus
{button A,PI(`greetcar.hlp',`A')}{button B,PI(`greetcar.hlp',`B')}{button C,PI(`greetcar.hlp',`C')}{button D,PI(`greetcar.hlp',`D')}{button E,PI(`greetcar.hlp',`E')}{button 
F,PI(`greetcar.hlp',`F')}{button G,PI(`greetcar.hlp',`G')}{button H,PI(`greetcar.hlp',`H')}{button I,PI(`greetcar.hlp',`I')}{button J,PI(`greetcar.hlp',`J')}{button K,PI(`greetcar.hlp',`K')}
{button L,PI(`greetcar.hlp',`L')}{button M,PI(`greetcar.hlp',`M')}{button N,PI(`greetcar.hlp',`N')}{button O,PI(`greetcar.hlp',`O')}{button P,PI(`greetcar.hlp',`P')}{button 
Q,PI(`greetcar.hlp',`Q')}{button R,PI(`greetcar.hlp',`R')}{button S,PI(`greetcar.hlp',`S')}{button T,PI(`greetcar.hlp',`T')}{button U,PI(`greetcar.hlp',`U')}{button V,PI(`greetcar.hlp',`V')}
{button W,PI(`greetcar.hlp',`W')}{button X,PI(`greetcar.hlp',`X')}{button Y,PI(`greetcar.hlp',`Y')}{button Z,PI(`greetcar.hlp',`Z')}

For information on an item, click on it with the mouse when you see the  cursor.

Click on one of the menu options for more information.

See Also:
Tools
Tutorial
Frequently Asked Questions

File Menu
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The File menu enables you to create new cards, open existing cards, save cards, and deal with 
printing issues.

See Also:
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New Card (Ctrl - N)
This option returns to the Main Screen where you can select a new project type. You 
can also click on the New button.



Open Card (Ctrl - O)
Choose File Menu—Open Card, or click on the Open Card button, to open a previously 
saved project file. The Open Card dialog box appears:

Select the drive where you have saved the card, highlight the desired card and click on the 
OK.

Save (Ctrl - S)
Use this option, or click on the Save button, to save the current card to disk. The Save 
As dialog box appears:

Click on the drive you wish to save the card to, type in a name if the card is a brand new 
file, and click on the OK button.

Save As (Ctrl - P)
This option saves the current card to disk under a different name. The Save As dialog 
box appears as above.

Print
Choose File Menu—Print or click on the Print button to send the current card to the 
printer.

Print Setup
Allows you to change your printer settings. The Print Setup dialog box appears:



Print Configuration
Choose File Menu—Print Configuration to configure Greeting Card Maker to work with
your printer.

Print Align
Lets you fine-tune your printouts for accurate printing.

Preferences
Use this option to change your user preferences for Greeting Card Maker.



Files
This area displays the previously opened and/or modified project files.



Exit
Use this option to quit Greeting Card Maker. This confirmation dialog box appears, 
verifying that you wish to exit the program:

Click on Yes to exit the program, No to continue working on a card.
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The Edit menu provides options that let you undo your last operation, cut, copy and paste items to
and from the clipboard, delete and duplicate items, select all text, and group items.

See Also:
Tools
Tutorial
Frequently Asked Questions

Undo (Ctrl - Z)
Choose Edit Menu—Undo, or click on the Undo button, to cancel the last operation 
performed and restores the file to its previous state.

Cut (Ctrl -X)
Use this option, or the Cut button, to place the selected object in the program’s clipboard. 



Copy (Ctrl - C)
Use this option, or the Copy button, to place a copy of the selected object in the 
program’s clipboard. 

Paste (Ctrl - V)
Choose Edit Menu—Paste or click on the Paste button to put an object stored in the 
clipboard on the document.

Delete (Ctrl - DEL)
This option deletes the selected object. 



Duplicate
Use Duplicate to make a duplicate copy of the selected object. 



Select All Text
Choose Edit Menu—Select All Text to select all text objects. This is useful when 
changing fonts and text styles.

Select All Objects (Ctrl -A)
This option is used to select all objects.



Group (Ctrl - G)
Use Group to combine all selected objects into one single object. 



Ungroup (Ctrl - U)
Choose Edit Menu—Ungroup to break up a grouped object into its component parts. 



Save as Symbol
This option saves a grouped object as a Logo object (.lgo) for later retrieval. 

View Menu
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The View menu enables you to either view or hide the rulers, status bar, the various toolbars, 
grids and guidelines. A checkmark next to the option indicates that the option is active.

See Also:
Tools
Tutorial
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Rulers
Choose View Menu—Rulers to turn the display of Rulers on/off. 



Status Bar
This option turns the display of the Status Bar on/off. 



Clipart Bar
Use this option to turn the display of the Clipart bar on/off. 



Navigator Bar
Choose View Menu—Navigator Bar to turn the display of the Navigator bar on/off.



Guidelines
This option turns the display of Guidelines on/off. 



Margins 
Use this option to turn the display of Paper Margins on/off. 



Grids
Choose View Menu—Grids to turn the display of Snap to Grids on/off. 



Object Outlines 
This option turns the display of Object Outlines on/off. 



Background 
Use this option to turn the display of the Background on/off.



Refresh Screen
This option re-draws the screen contents. 



Zoom
This option changes the magnification of the screen.



Card Panel
This option lets you select the card panel you wish to view: letterhead, env., bus card, fax.
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The Insert menu enables you to insert and shape text, insert clip art and logos.

See Also:
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Text 
Inserts Text into the project. 



Shape Text 
Inserts a Shaped Text object into the project. 



Clip-Art 
Inserts a Clipart object into the project. 

Symbol
Inserts a Logo object into the project.
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The Format menu lets you set font attributes, text effects, and set layers and alignment.

See Also:
Tools
Tutorial
Frequently Asked Questions

Font
Choose Format Menu—Font to set font attributes for the selected text. This dialog box 
appears:

Text Effects
This option lets you set Headline text, drop-shadows, fills, and background color This 
dialog box appears:

Note: Text Effects are only available in Windows™ 95.



Center 
Choose Format Menu—Center to center text horizontally or vertically on the page. 



Align 
This option controls object alignment - left, right, top, bottom, center.



Draw Order
Choosing Format Menu—Draw Order lets you control object layer position - bring to top,
send to bottom.

Add Guidelines at Margins
Choose Format Menu—Add Guidelines at Margins to automatically set guidelines at 
the paper margins. 

Remove All Guidelines
This option removes all guidelines.



Card Setup
Here you can enter the new dimensions for your card. Enter the height and the width of 
the card when folded, in other words, the size of each card panel. You can also enter 
dimensions for envelopes which are not the standard size.
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Th Help menu provides access to the online help file and program copyright information.
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Index
Choose Help Menu—Index brings up the Greeting Card Maker help file. 



Using Help
This option brings up the Microsoft Help engine.



About 
This option provides information on Greeting Card Maker.
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General
What kinds of cards can I print?
Greeting Card Maker supports several kinds of cards - some you can print on regular paper, and some 
you can print on pre-printed card stock. The cards you can print on regular paper don’t require any 
special paper or cardboard. These include the Quarter Fold cards and the Half Fold cards. Quarter Fold 
and Half Fold cards can be printed in either portrait orientation or in landscape orientation.

What are pre-printed card stock cards?
Pre-printed card stock cards are cards that you can obtain from different manufacturers that already have 
designs printed on them. The cards featured in Greeting Card Maker are special cards, since they are 
blank on the inside. You can create your own sentiments and graphics on the screen, then print your 
designs on the real card. 

How do I order pre-printed stock cards?
On the Clipart bar there is a button labeled Order Cards. Each card displayed on the screen has 
manufacturer and item # information on the status bar. Be sure to have this information ready when you 

are ready to place an order. Click here  for more information.

What’s the difference between portrait and landscape cards?
Portrait cards are viewed “upright” or taller than they are wider. Landscape cards are wider than they are 
taller.

Using Greeting Card Maker
How do I see the different card views?



The Navigator Bar is a small floating toolbar with four buttons on it. Pressing each of the buttons will 
switch you to the indicated view.

How do I change text? 
To change any piece of text, simply double-click on it with the mouse. The Edit Text dialog box will 
appear where you can type and format the text.

How do I import my own pictures?
There are two ways. The first is through a Menu - choose Insert/Clip-Art selection. A dialog box will 
appear where you can browse through your directories and select the file you want to import. Greeting 
Card Maker supports most popular graphics file formats. A preview of the highlighted file will appear in the
Preview box.

When I import my own 256 color pictures my screen colors get messed up?
This is a common problem when Windows is configured to display only 256 colors and you have several 
256 color images on the screen at the same time. Each image is competing for the color palette, and only 
one can use all 256 colors at one time. We strongly recommend that you configure Windows to run in 16-
bit color (High Color) or higher, if your video card supports it. Please refer to your Windows User’s Guide 
or your video card guide for information on how to configure Windows to display more than 256 colors.

I want to print on my own cards, how do I change the card dimensions in the program?
There is a dialog box named Card Setup, available through the Format menu. Here you can enter the 
new dimensions for your card. Enter the height and the width of the card when folded, in other words, the 
size of each card panel. You can also enter dimensions for envelopes which are not the standard size.

Can I customize the sentiments?
You can edit, customize, and personalize sentiments just like you can any other text object simply by 
double-clicking on it.

What are Signature Symbols?
Signature Symbols are combinations of text and graphics that are usually found on the back of cards. You
may think of them as “trademarks” or “logos”. In Greeting Card Maker, Signature Symbols are actually 
grouped objects saved as .sym type files. You can create your own Signature Symbols by grouping your 
own text and graphic, then saving them through the Edit/Save as Symbol menu. To use them again, click
on the Insert Symbol button on the left toolbar.

Printing
Why do I need to configure Greeting Card Maker to work with my printer?
Printing on pre-printed stock cards requires that you correctly feed cards into your printer. The purpose of 
the Configure Print dialog box is to setup the program with settings for your particular printer, including 
manual feed operations. 

How do I feed the cards in for manual feed?
Whenever you print a Half Fold card or a Pre-Printed Card stock card, two-sided printing will be required, 
that is, you will have to turn the page over and re-feed it into the printer so that you can print on the other 
side. A dialog box will appear with a graphic indicating how to feed your card or paper into the printer. This
graphic will be based on information you provided in the Configure Printer dialog box, so it is important 
that these settings are correct.

What if the cards don’t print right
In the event that your cards don’t print out correctly, there are two main things you can try. The first is to 
review your Printer Configuration settings. Make sure that the settings in this dialog box are correct for 
your printer. In the event that the correct settings don’t seem to work, experiment with different settings 
and observe the effect they have on your print-outs. 

The second thing you can try if your cards don’t print out correctly aligned on the card is to try the Print 



Align function. Located in the File—Print Align menu, you can manually shift the card in the direction 
you want to align it in. A graphic displays the amount that you are nudging your design over.

Anytime you are printing on paper that is not standard size (greeting cards, for example), there are many 
variations in the way different printer manufacturers deal with this issue. We have tried to include as many
settings as necessary in order to compensate for these differences. The best thing to try, whenever you 
are printing on pre-printed cards, is to practice first by printing on a test card of the same size as your real
card, and observe your results.

How do I fold quarter fold and half-fold cards?
There is a section entitled Folding Cards in this documentation. It contains diagrams showing how to fold 
the different kids of cards, including 

Some special text effects don’t print right. What’s Wrong?
Some printer drivers, including the Hewelett Packard Deskjet 660 series color printers have drivers that 
do not support some of the Shape Text effects featured in Greeting Card Maker. We recommend that you
contact Hewelett Packard directly at their customer support phone included in your user’s guide and 
inquire as to newer versions of their printer drivers. 
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Expert help uses a visual system for providing you with information on the different screens and features 
of this program.

To obtain help on any topic, click on the Help menu from anywhere in the program or on the 

 icon. Doing so brings up the appropriate help topic for the current screen that you are on.
Most of the major screens and dialog boxes in this program are reproduced in miniature form in 

this help file. As you pass the mouse cursor over the image, the arrow-pointer changes to the shape of a 
hand 

 indicating that you can click on that area. (This is called a “hotspot.”) For information on any field, 
button, hotspot, or feature, simply click on the area you are interested in and a pop-up description 
appears or it jumps you to that specific topic. Occasionally, you see the Expert “X” (

) in some portions of the help file preceded by “click here;” it will be a jump to another topic or location 
in the help file.

The pop-up or jump description may consist of up to 3 parts. They include:
Definition and/or general information about the item you have selected.
Action to take. Any instructions or options available for the topic.
A link (usually in green) to a related topic. If further information is available for the item 
you have selected, the link will take you to the new topic of interest.
Another way of quickly accessing information for a particular topic is through the use of the 

glossary buttons located in the non-scrolling region at the top of every help screen. Clicking on each letter
provides you with a quick alphabetized index listing in a pop-up box.
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Your purchase of an Expert product includes free product support to help you get the most out of your 
software. All Expert products are thoroughly tested and come with a Help File, User’s Guide and/or 
Online Manual. In most cases, the answers to many of your questions are in the Help File, User’s Guide 
and/or Online Manual.
If you are having problems starting or running the program, please feel free to contact us. 
24 Hour Automated Support

 Find answers to frequently asked questions on the worldwide web at http://www.expertsoftware.com
 Use our Fax Back System for support and product information at (800) 772-5706. 

E-mail Addresses
 You can send e-mail to support@expertsoftware.com or sales@expertsoftware.com

Mailing Address
 800 Douglas Road, Suite 750, Coral Gables, FL 33134 or
 P.O. Box 144506, Coral Gables, FL 33114-4506.

Telephone Product Support
Contact a friendly Expert Product Support Specialist Monday through Friday, 9:00AM to 5:00PM EST 
(Eastern Standard Time). Telephone (305) 567-9996 or fax (305) 569-1350.
If you call, you should be at your computer. Be ready to give the Product Support Specialist the 10-digit
program version number from the front of your program disk or back of the CD jewel case, as well as 
the following information:
If you have a Macintosh®–compatible computer

 Please have the model, system software version and amount of memory available.
If you have Windows®– or MS-DOS®–compatible computer:

 The version of DOS that is installed on your computer. (You can determine the version by typing VER 
at the DOS prompt.)

 The version of Windows® installed on your computer.
 The type of hardware you are using:

The brand of computer you own, 
CPU type (80386, 80486, Pentium®), 
Video type (EGA, VGA, Super VGA),
Model and type of video card, and 
Model and type of printer.

 The exact wording of any messages that appeared on the screen.
 What happened and what you were doing when the problem occurred.

We encourage Windows® 3.x (or MS-DOS 6.x) users who need product support to print an MSD report. 
Have it available for the Product Support Specialist who answers your call. You will find the MSD 
(Microsoft Diagnostics) program in either the Windows or the DOS directory.



Ordering Information
{button A,PI(`greetcar.hlp',`A')}{button B,PI(`greetcar.hlp',`B')}{button C,PI(`greetcar.hlp',`C')}{button D,PI(`greetcar.hlp',`D')}{button E,PI(`greetcar.hlp',`E')}{button 
F,PI(`greetcar.hlp',`F')}{button G,PI(`greetcar.hlp',`G')}{button H,PI(`greetcar.hlp',`H')}{button I,PI(`greetcar.hlp',`I')}{button J,PI(`greetcar.hlp',`J')}{button K,PI(`greetcar.hlp',`K')}
{button L,PI(`greetcar.hlp',`L')}{button M,PI(`greetcar.hlp',`M')}{button N,PI(`greetcar.hlp',`N')}{button O,PI(`greetcar.hlp',`O')}{button P,PI(`greetcar.hlp',`P')}{button 
Q,PI(`greetcar.hlp',`Q')}{button R,PI(`greetcar.hlp',`R')}{button S,PI(`greetcar.hlp',`S')}{button T,PI(`greetcar.hlp',`T')}{button U,PI(`greetcar.hlp',`U')}{button V,PI(`greetcar.hlp',`V')}
{button W,PI(`greetcar.hlp',`W')}{button X,PI(`greetcar.hlp',`X')}{button Y,PI(`greetcar.hlp',`Y')}{button Z,PI(`greetcar.hlp',`Z')}

For information on an item, click on it with the mouse when you see the  cursor.

24 Cards for Only $16.80! 
PLUS…

a bonus of 10 FREE cards and envelopes
(a $7.00 value)

Print your customized greetings on the colorful collection of pre-
printed cards featured in Expert Greeting Card Maker and Holiday 
Card Maker. Each card is printed on quality paper stock and is 
custom designed to use with this program.

Blank Cards are also available to print your original designs on!    
All cards are 4 ¾" x 6 ¾" size and include matching envelopes.

(800) 272-7792
Fax (914) 923-4611

Mention Expert Software when you call, to get 10 cards and envelopes free!    (A
$7.00 value), or mail your order along with a check for $20.30 ($16.80 for 
purchase + $3.50 shipping) payable to Fintech Software. 

Fintech Software Corporation
34 Ridge Road

Chappaqua, NY 10514
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No topics available.



B
No topics available.



C
Choosing a Ready-Made Design
Configuring Your Printer
Constructing and Editing Your Own Cards
Creating a Sample Card
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E
Edit Menu



F
File Menu
Folding Cards
Folding Half-Fold LandscapeCards
Folding Half-Fold Portrait Cards
Folding-Quarter Fold Landscape Cards
Folding-Quarter Fold Portrait Cards
Format Menu
Frequently Asked Questions
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H
Help Menu
How to Use Expert Help



I
Insert Menu
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L
Left Toolbar



M
Main Interface
Main Toolbar
Menus



N
Navigator Bar



O
Ordering Information



P
Printing
Product Support
Program Overview
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S
Setting Your Preferences
Special Text Effects/Shaping Text/Adding Sentiments
Spell-checking, Thesaurus, and Rhyming



T
Trademarks, Copyrights and Credits
Tutorial
Types of Cards



U
Using Signature Symbols
Using the Card Editor Screen



V
View Menu



W
Working With Text
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Z
No topics available.






